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Welcome
This section introduces Avaya 3456 UC Client and describes the available 
features.

Navigation
• Your new Avaya 3456 UC Client (page 5)

• Requirements (page 6)

• Online help (page 6)

• Avaya preferred configurations (page 6)

• Related publications (page 6)

Your new Avaya 3456 UC Client
The current Avaya 3456 UC Client offering provides instant messaging, and 
voice and video communications. The Avaya Communication Server 1000 
(Avaya CS 1000) and Avaya 3456 UC Client provide voice, video 
communication with rich telephony features.
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Requirements
The following basic hardware specification is required to operate the Avaya 
3456 UC Client:

• Intel Pentium III 1.3 GHz or equivalent

• Windows 2000/XP/Vista

• 512 MB RAM

• 50 MB hard disk space

• 16 Bit, full-duplex sound card

• IP connection

Depending on the configuration of your workstation or laptop, you may also 
need to obtain a microphone and speakers, or a USB headset with 
microphone. If it is your intention to utilize the softphone video call/
conferencing features, you will also need a webcam.

Online help
For detailed information about specific client features, see the help 
documentation provided with Avaya 3456 UC Client. To access help, in the 
Avaya 3456 UC Client, click Actions and then click Help.

Avaya preferred configurations
Following list contains preferred configurations for Avaya 3456 UC Client

• Disable the provisioning server on the phone, On the phone, navigate to 
Preferences > Advanced > No login server available.

• Configure only the G711 and G729 voice codecs for the Avaya 3456 UC 
Client.

• Ensure that the fixed single port is defined. Navigate to Account Settings 
> Topology > Port Range to set the port.

• Ensure the registration refresh time is set to five minutes. This keeps the 
registration timer short enough to recover quickly in case of network 
failure.

• To make the Avaya 3456 UC Client DTMF work with the Media Application 
Server (MAS), ensure that SIP > Account > Topology > Enable ICE is not 
selected.

Related publications
For more information, see the following related publications:

• Avaya CS 1000E suite of documentation
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Feature overview
This section describes features that are available on the Avaya 3456 UC 
Client.

Navigation
• Starting up (page 7)

• Signing in (page 8)

• Making a call (page 9)

• Receiving calls (page 11)

• Placing calls on hold (page 11)

• Mute (page 13)

• Call Transfers (page 13)

• Conference Calls (page 26)

• Voicemail (page 30)

• Video Phone (page 32)

Starting up
Start the Avaya 3456 UC Client by double-clicking on the desktop icon, or by 
clicking on the Start menu and navigating to the Avaya 3456 UC Client 
program group and clicking on Avaya 3456 UC Client.
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Signing in
The Avaya 3456 UC Client should sign in to your SIP account automatically if 
your account has been correctly configured. In some circumstances 
(depending on how the system administrator has configured the softphone), 
you may be asked to authenticate to a login server during application start up. 
If you are unsure how to login, see your system administrator.

Screen layout
Before continuing, it would be worth spending some time on the interface 
layout. Not all function buttons are visible when the phone is inactive - for 
example, call transfer and hold options do not appear unless the phone is 
engaged on a call. Other function buttons, such as the voicemail notification 
button, only appear unless a) configured to do so (see the system 
administrator) and b) when you receive a message.
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Making a call
Calls can be made from the Avaya 3456 UC Client in a number of different 
ways. Users can make calls by double-clicking on any name in the contact list, 
by typing a number in using the keyboard and pressing Enter, or by opening 
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the dial pad and using the mouse to click on the numbers required. The 
following instructions will show you how to open the dial pad and dial a number 
using the mouse.

1 Click the dial pad button

2 Using the mouse, click on the dial pad numbers that you would like to dial. 
The number appears on the display screen.

3 Click the dial button  . End the call by clicking on 



- 11 -
Feature overview

Avaya 3456 UC Client
User Guide

NN43080-100   02.01 Standard
7.5 November 2010

Receiving calls
When a call is received by the UC Client, a number of things will occur. First, 
the phone will ring (if sound is enabled on your system); second, the caller’s 
number or ID is displayed on the 3456 display screen.

Thirdly, if the Avaya 3456 UC Client is running in the background, i.e., if you 
are working in another application, a web browser, for example, you will still 
see a visual notification of the call, in the form of a pop-up messages that 
appears just above the clock on the Windows task bar.

To answer the call:

• Click on the found on the Avaya 3456 UC Client interface.

or

• Click on the found on the desktop pop-up.

To reject the call and forward it to your voicemail service (if configured), click 
on  .

Placing calls on hold
Calls can be placed on hold at any time. When a call is on hold, you cannot 
hear the caller and they cannot hear you. When a call is on hold, the message 
‘Call on hold’ is displayed on the screen and the hold button  is 
highlighted.
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When a call is on hold, it is possible to make a second call by pressing the 
Start another call button .

Hold and resume
To place a call on hold, press the Hold button during the call. To resume the 
call, just press the Hold button again.

Hold and Open Another Call
1 During a call, press the Start another Call button . A new dial tab 

opens in the interface window. 

2 Dial the new recipient’s number.

3 Click the  button.

4 To switch between calls, click on the tabs. Whenever you select a tab, all 
other calls will be placed on hold.

5 To end a call with either party, click the  button.
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Call waiting
When you are on a call and another call comes in, the phone will ring and the 
second call will appear in a tab on the phone screen. To answer the call and 
place the current call on hold, click on the new caller tab. The new call will be 
answered the moment you click on the tab, so there is no need to click the 
green answer button.

Mute
At any time during a call, you can mute your microphone so that the caller 
cannot hear what you are saying - you, however, will still be able to hear them. 
To mute a call, click on the Mute button (the Mute button is only displayed 
during calls).

Call Transfers
The Avaya 3456 UC Client offers users a number of different ways to transfer 
calls:

• Blind transfer – Pass a call directly to another extension without waiting 
for an acknowledgment or busy signal from the destination.

• Announced transfer – Ring the destination extension first and announce 
the call before transferring it through.
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• Quick transfer – Pass the call straight to a number in your quick transfer 
list (more on this later in this section), or to your chosen Default quick 
transfer destination.

Each of these transfer methods, as well as the creation of a Quick Transfer list, 
is examined during the course of this section.

Blind Transfer
A blind transfer is probably the easiest method of transfer available on the 
Avaya 3456 UC Client interface and is performed in the following way.

1 Answer the call by clicking on the  button.

2 During the call, press the drop-down menu button located just to the right 
of the Default Transfer button (the transfer button will only appear on 
phone display when an active call is in progress).

3 Select Transfer this call.
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4 When prompted, enter the destination number using either the dial pad or 
the numeric keys on your keyboard.

5 Click the Transfer button.

6 The call is passed to the transfer destination and your phone hangs up.
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Announced Transfer
An announced transfer is often seen as the preferred method of call transfer, 
because it enables you to find out whether the destination recipient is available 
and ready for the transfer or not.

To perform an announced transfer:

1 Answer the call by pressing the  button.

2 During the call, press the drop-down menu button located just to the right 
of the Default Transfer button (the transfer button will only appear on 
phone display when an active call is in progress).

3 Click on Call then Transfer
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4 A new tab opens and the caller is placed on hold. Enter the transfer 
destination’s number

5 Click the  button.

6 When the recipient answers, announce the caller and then press the 
Transfer button.

Note:If the recipient does not answer, y ou can return to the call originator 
by clicking the  button to disconnect the second call (ensure that the 
second call tab is selected, otherwise y ou will disconnect the caller).
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7 The call is transferred to the destination and your phone hangs up.

Quick Transfer List
A Quick transfer list can be created to provide users with fast access to 
common transfer destinations – for example, a PA may require fast access to 
a select group of managers that they commonly field calls for. Once created, 
a quick transfer list can be accessed during an active call and the caller can 
be transferred quickly to any of the numbers.

Note: When you transfer a call using the quick transfer list, you are in effect 
performing a blind transfer. In other words, y ou will not be able to announce 
the call; the caller will simply be passed directly to the destination whether the 
recipient is available or not.

Any number in the quick transfers list can be selected as the Default transfer 
number. Calls can be quickly transferred to the Default number by simply 
clicking the Default Transfer button.

Creating a Quick Transfer List
A quick transfer list can be made up of as many contacts as y ou wish, but bear 
in mind that the longer the list, the loner it will take you to find the right contact 
during a call, thereby defeating the object of the ‘quick transfer’ list.
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To create a quick transfer list:

1 From the main interface screen, open the File menu and select 
Preferences.

2 Click on the Quick Transfer button
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3 Click the Add button.
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4 Enter the full name and phone number of the quick transfer contact.

Note: To set this contact as the Default quick transfer contact (the number 
tha calls will be forwarded to if you click on the Default Transfer button), 
tick the check-box. The default contact will appear with a tick next to it in 
the list of quick transfer numbers.

5 Click OK button.

6 The new contact is displayed in the quick transfers list. Click the OK button 
to finish.

Quick Transfer List Transfers
To perform a transfer using a number from your quick transfers list:

1 Answer the call by pressing the  button.

2 During the call, press the drop-down menu button located just to the right 
of the Default Transfer button (the default transfer button will only appear 
on phone display when an active call is in progress).

Note: To send the call directly to your default quick transfer contact, just 
press the Default Transfer button.

3 Select the name of the person to whom you would like to transfer the call.
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4 The call is transferred and the phone hangs up.

Contacts
The lower half of the Avaya 3456 UC Client interface is dedicated to Contacts 
and call History. The following sections deal briefly with the principles of 
adding, viewing and calling contacts.

Creating Contacts
Contact information can be imported from a variety of sources, including CSV 
files and Outlook Exchange servers, however, th is guide deals exclusively 
with creating new contact profiles. For instructions on importing contact 
information, see the in-built help file that is accessed by clicking on the Help 
menu.

To create a new contact profile:

1 From the main phone screen, open the Contacts menu and select Add a 
Contact. If the Address Book panel is open (the lower half of the Avaya 
3456 UC Client interface), click on the Add a Contact button.
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2 Enter the name details of the contact and select a Group (e.g., Work, 
Friends, etc).

3 In the lower half of the screen, select a contact type (e.g., Home, Office, 
Softphone, etc) from the contact Method drop-down menus, and enter the 
contact’s phone number(s) in the corresponding Number/Address 
field(s).
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4 If you entered more than one contact number, open the top-right drop-
down menu and select the preferred default contact method that will be 
used when you double-click on the contact’s name in the address book.

Note: If you enter a softphone number, you have the option of viewing the 
contact’s availability. Tick the Show this contact’s availability check-box 
to enable this feature.

5 Click the OK button

Viewing Contacts
Contacts are arranged into Groups in the Address Book panel –each 
contact’s group allocation is determined when the contact profile is created, 
see the previous section, ‘Creating Contacts’. To view a contact’s profile, 
simply click on their name in the Address B ook panel.
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Dialing Contacts
To dial a contact straight from your Address Book, either double-click on the 
contact’s name or, in cases where more than one number exists for the 
contact, single-click and then select the required location number from the 
profile bubble.

Contacts can also be called by right-clicking on the contact in the Address 
Book and selecting Call Contact.

Contact information stored in Microsoft Outlook 2003 can also be utilized by 
the Avaya 3456 UC Client. Simply open a contact in OUtlook and click on the 
Avaya badge found on the tool bar (if you cannot see the Avaya badge, open 
the View menu and select Toolbars, and check that eyeCall is ticked). A list 
of numbers stored for that contact are displayed in a drop-down menu. Click 
on the number that you would like to dial.

Note:The Avaya 3456 UC Client will start automatically if it is not currently 
running in the background.
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Conference Calls
There are two ways in which a conference call can be established on the 
Avaya 3456 UC Client:

• Click the Vedio button to open the video panel.

• Place a call to the first participant. Your video automatically appears on 
their screen, but they have to enable their streaming so that you can see 
them.

• Click the Start button to open another tab and place the first call on hold. 
Dial the next participant. Repeat this step until all participants are on the 
call.

• Click the Conference All button to join all participants into one conference 
call.
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• Start or receive a call, open other calls using the Start Another Call button 
(see ‘Hold and Open a Second Call’) and then, once connected, click on 
the Conference All button. All active calls will be joined to one 
conference.
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Managing Conference Calls
Removing Participants
A participant can be removed from the conference call and placed into a 
separate call in the following way:

1 Open the drop-down menu found at the end of the participant’s details on 
the phone screen.

2 Choose between End Call(to end all communication with the caller) and 
Separate Call from Conference (to remove the caller from the 
conference but keep the caller on Hold in a separate tab).
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Disbanding Conferences
To end a conference call, but keep all callers on separate ‘held’ lines in their 
own tab, open the Options menu, located benath the call display screen, and 
select Disband Conference. Each caller can be taken off Hold by clicking on 
the corresponding tab.

Suspending a Conference
Conferences can be suspended by clicking on the Hold button. Participants 
will have a hold icon next to their name on the display screen when a 
conference is suspended.
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Voicemail
The Avaya 3456 UC Client can be configured to regularly check your Avaya 
Communication Server 1000 (Avaya CS 1000) voicemail box.

Voicemail Settings
Your voicemail account can be accessed by dialling the voicemail attendant’s 
extensions (101 by default), but unless configured to do so, the application will 
not automatically check for and notify you of new messages. To configure 
automatic checking and notifications:

1 From the main phone screen, open the File menu and select Account 
Settings.

2 Highlight your account and click on the Edit button.
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3 Click on the Voicemail tab.

4 Trick the Check for Voicemail check-box.

5 Enter the number you would normally dial to access the voicemail 
attendant in the Number to dial for checking mail text box (by default, 
the voicemail attendant’s extension is 101, check with your system 
administrator if you are unsure).
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6 Click the OK button.

7 Click Apply.

8 Click Close.

The Avaya 3456 UC Client is now configured to check the Avaya CS 1000 
server for voicemail messages. When a message arrives, an envelope icon 
will appear on the interface.

Accessing Voicemail
Voicemail can be accessed from the Avaya 3456 UC Client in one of two ways: 
dial the voicemail attendant extension (101 by default), or click on the 
envelope icon (the envelope icon only appears when there are unheard 
messages in your inbox).

Video Phone
The Avaya 3456 UC Client is equipped with a videophone feature. To make a 
video call, you and the call recipient will need a webcam enabled softphone or 
video-enabled hardware phone –1535 video IP phone, for example.
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Making a Video Call
To make a video call:

1 Click the Video button to open the video panel.

2 Enter the number of the person you would like to call and then click the 
Video Call button. Alternatively, right click on a contact in the Address 
Book and select Video Call.
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Receiving a Video Call
When you receive a video call, the video panel will open automatically when 
you answer the call and you will be able to see the caller via their own video. 
To start sending your video, click Start Video.

Note: The caller and recipient can start or stop their video stream at any time 
during a call.

Video Conferencing
Note: The Avaya 3456 UC Client supports up to six video conference 
attendees. In order to take part in the video conference, the other participants 
must be using video capable phones.

To start a video conference:

1 Open the video panel by clicking on the Video button.

2 Place a call to the first participant – your video will automatically appear 
on their screen, but they will have to enable their own streaming so that 
you can see them.

3 Click the Start another button to open another tab and place the first call 
on hold. Dial the next participant. Repeat this step until all participants are 
on the call.
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4 Click the Conference All button to join all participants into one conference 
call.

Managing Conference Calls
Most conference controls, such as participant removal, suspend, and disband, 
are managed from the main phone interface during a video conference. Users 
can stop their own video output by clicking on the Stop my Video button found 
on the video panel.

Removing Participants
A participant can be removed from the conference call and placed into a 
separate call in the following way:

1 Open the drop-down menu found at the end of the participant’s details on 
the phone screen.

2 Choose between End Call (to end all communication with the caller) and 
Separate Call from Conference (to remove the caller from the 
conference but keep the caller on hold in a separate tab).
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Disbanding Conferences
To end a conference call, but keep all callers on separate ‘held’ lines in their 
own tab, open the Options menu, located beneath the call display screen, 
and select Disband Conference. Each caller can be taken off hold by clicking 
on the correspond tab.
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Suspending a Conference
Conferences can be suspended by clicking on the Hold button . 
Participants will have a hold icon next to their name when a conference is 
suspended.
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Troubleshooting
This chapter describes various troubleshooting tips.

Navigation
• Configuration changes do not work (page 38)

• Call Detail Reporting (page 38)

Configuration changes do not work
When making configuration or preference changes, you must first select the 
account to which to apply the changes. By default, the first account in the list 
is selected.

Call Detail Reporting
Call Detail Reporting (CDR) is available for all universal expansion connectors 
(UEXT) and for Session Initiated Protocol (SIP) Trunk.
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